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Лабораторна робота №1. Робота з інструментами у растровому графічному 

редакторі  

 

 

Увага!  

Папку цієї і кожної із наступних робіт теж створюєте на Google Drive 

у папці дисципліни і виконуєте в ній всі завдання відповідних робіт з 

допомогою web-версії додатку photopea.com, періодично зберігаючи 

файли, а не шляхом завантаження файлів із локального ПК. 

ЗАВАНТАЖЕНІ ФАЙЛИ ІЗ ПК ПЕРЕВІРЯТИСЯ НЕ БУДУТЬ!!!  

 

Уважно прочитайте наступну інструкцію. 

Інструкція для здачі робіт: на Вашому Google Drive створіть папку групи, 

наприклад IPZ11_lastname, де lastname - це Ваше прізвище (Якщо вже є, нову 

створювати не потрібно). У Вашій папці групи створіть папку 

web_design_lastname, в ній потрібно створити папку lab1_lastname, в якій 

потрібно виконувати завдання відповідної роботи безпосередньо на Google 

Drive. 

У випадку неможливості чи не вірного ходу виконання якогось із завдань, 

попросіть викладача про допомогу,  якщо виконуєте це дома, створіть файл 

zvit_lab1.docx і опишіть в ньому цю проблему.  

Після завершення виконання даної роботи для папки web_design_lastname  

надайте для облікового запису mariia.dutchak@pnu.edu.ua доступ з правами 

коментування!!!! НЕ РЕДАГУВАННЯ!!!, для всіх решту ставите “Обмежений 

доступ”.  

Посилання на папку предмету із Google Диску і стартову сторінку хостингу 

вкажіть тут: 

  https://docs.google.com/forms/d/e/1FAIpQLSescc-

Tzx9GP24oNBAKhy_vokuvTLzjSF1C2DkNyDul23HYVg/viewform?usp=pp_url 

 

Форму заповнюєте тільки один раз, за винятком зміни розміщення папки 

предмету на Google Drive. 

При здачі робіт у Classroom потрібно вказати посилання на відповідну папку 

labN_lastname, де N- номер роботи. У файлах після здачі роботи вносити зміни 

заборонено. Якщо Ви хочете в них щось змінити, відміняєте здачу роботи і здаєте 

повторно.  

 

Примітка: Якщо у Вашому графічному редакторі не можете знайти потрібні 

шрифти, фільтри, стилі, форми пензлів і т.д. спробуйте знайти їх у мережі Інтернет 

і встановити їх у Ваш графічний редактор, наприклад тут. Для цього у вікні 

відповідних інструментів шукаєте пункти на зразок: імпортувати, завантажити, 

встановити і вибираєте завантажений з мережі Інтернет файл. Якщо ви 

завантажили архівом, то його попередньо потрібно розархівувати. Зверніть увагу, 

що у вікні вибору файлу відображається потрібний формат для того чи іншого 

mailto:mariia.dutchak@pnu.edu.ua
https://docs.google.com/forms/d/e/1FAIpQLSescc-Tzx9GP24oNBAKhy_vokuvTLzjSF1C2DkNyDul23HYVg/viewform?usp=pp_url
https://docs.google.com/forms/d/e/1FAIpQLSescc-Tzx9GP24oNBAKhy_vokuvTLzjSF1C2DkNyDul23HYVg/viewform?usp=pp_url
https://www.brushlovers.com/
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інструменту, крім того відкривається папка в якій графічний редактор шукає 

збережені файли. Знаходите Ваш завантажений файл із відповідним розширенням 

і клікаєте на кнопку “Завантажити (Імпортувати, Встановити і т.д.)”   

Папка з деякими завантаженнями тут. 

 

Хід роботи 

 

Вивчіть і намагайтеся по максимуму використовувати стандартні 

комбінації клавіш, наведені у меню Більше-Поєднання клавіш додатку 

Photopea.com, їх перелік також наведений у Лекції 1.  На знання цих клавіш 

пізніше буде тестування. 

 

1. На Google Drive перейти у папку lab1_lastname, знаходячись в якій обрати 

Створити - Більше - Photopea. Якщо даного додатку у вас немає, клікнути 

Підключити інші додатки, відшукати його у переліку додатків і встановити. 

2. Далі клікнути на Профіль - Увійти - Log in with Google. Після вдалого входу, 

закрийте додаток Photopea і продовжити виконання наступних завдань. За 

потреби, для блокування реклами можете встановити додаток Adblock Plus чи 

будь-який інший додаток. 

3. Створити новий документ: знаходячись у папку lab1_lastname обрати 

Створити - Більше - Photopea. У вікні ввести розміри – 1000, 1000 пікселів. 

4. Зайти у пункт меню Вікно, переконатись, що увімкнені наступні елементи: 

шари та історія, якщо ні, то поставити навпроти відповідного інструменту 

галочку. Решту поки можна не вмикати. Пізніше увімкнете при потребі.  Для 

закриття зайвого елемента, у контекстному меню його заголовка клікнути 

Закрити. 

5. Використовуючи кнопку-олівець  намалювати лінію. На панелі 

 змінити ширину лінії на 20 рх, провести іншу лінію. Якщо не 

виходить нічого намалювати, переконайтесь, що  шар Background активний. 

6. Зберегти файл у папці lab1_lastname під назвою  lastname.psd, де lastname - 

ваше прізвище.  

Для збереження обрати Файл - Зберегти (Google Drive). Якщо даний пункт 

відсутній, закрити вкладку із додатком Photopea без збереження і виконати 

повторно пункти 1, 4, 5. Якщо не допоможе, зверніться до викладача по 

допомогу. Зверніть увагу, що додаток Photopea при першому зберіганні з 

допомогою пункту меню Файл - Зберегти (Google Drive) зберігає файл не у 

поточній папці, а у кореневій папці Google Drive. Щоб перенести файл у папку 

відповідної роботи у контекстному меню документа потрібно обрати 

Перемістити і перемістити файл lastname.psd у папку lab1_lastname. Таку дію 

потрібно буде виконувати із кожним новоствореним документом через Створити 

- Більше -…. одразу після його створення і зберігання, а потім продовжувати 

роботу із ним, подальше зберігання вже буде у потрібній папці.  

 

Зверніть увагу, що:  

https://drive.google.com/drive/folders/19ZPIC_1XnPFoET_lO57zzen5LpPscGo3?usp=sharing
https://docs.google.com/document/d/1Z3zS_r-D5wD7KNbhv-r6sLVJ7yYo9lWI/edit?usp=sharing&ouid=109219261408206469601&rtpof=true&sd=true
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➢ Для того, щоб файл створювався у потрібній папці Вашого Google Drive, 

його потрібно створювати через Файл ->  Створити, а при зберігання обрати 

Зберегти більше - PSD to Storage - Google Drive і обрати потрібну папку. 

➢ Для відкриття файлу із Google Drive  обираєте Файл ->  Відкрити більше -> 

Storage -> Google Drive.   

Якщо це виконувати через меню Файл ->  Відкрити чи Файл ->  Зберегти, то 

файли відкриватимуться (зберігатимуться) з (на) локального (-му) ПК, так 

ніби Ви працюєте із десктопную версією програми.  

➢ Якщо створювати документи через Створити  -> Більше -> Photopea, то при 

першому зберіганні з допомогою пункту меню Файл - Зберегти (Google 

Drive), додаток Photopea створює документи не у відкритій папці Google 

Drive, а в його кореневій папці. Для перенесення файлів у папку відповідної 

лабораторної роботи, потрібно клікнути на нього правою кнопкою миші, 

далі "Перемістити в" і вказуєте папку куди перенести. Таку дію потрібно 

буде виконувати із кожним новоствореним документом одразу після його 

створення і зберігання, а потім продовжувати роботу із ним, подальше 

зберігання вже буде у потрібній папці. Ні в якому разі не завантажуйте файл 

на ПК з подальшим його завантаженням у потрібну папку Google Drive. Такі 

файли перевірятися не будуть. 

7. На лівій панелі на елементах  двічі клікнути кнопкою мишки на 

верхньому квадраті, появиться вікно для зміни кольору. Змінити колір та 

провести лінії різних кольорів. 

8. клікнувши на  зі списку вибрати форму лінії і ширину. Знайти 

символ “зірочка” або “листочок” зі списку. Провести лінії різної ширини. 

9. клікнути на кнопці олівця, притримати і у боковій панелі вибрати інструмент 

пензлик . Аналогічно виконати всі дії, що робили з олівцем. 

10. клікнути на  і виділити прямокутну область. Провести пензлем через 

прямокутник. (Зауваження: Інструменти працюють тільки у виділеній 

області). 

11. Забрати виділення Виділення – Прибрати виділення (або Ctrl+D). 

12. клікнути на  , тримаючи зі списку вибрати . Виділити округлу 

область. Провести пензликом через круглу область. Забрати виділення Ctrl+D. 

13. Виділити прямокутну область  та залити її кольором . Зробити інші 

прямокутники та кола і залити різними кольорами. Забрати виділення Ctrl+D. 

14. Виділити прямокутну область вибрати команду з меню Виділити –

Трансформувати виділення, клікнути за межами прямокутника і тримаючи 

кнопку мишки перевести курсор вверх або вниз, натиснути Enter. 

15. Утворити прапор України, заливши кольорами два прямокутники. 
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16. Виділити прямокутну область, тоді клікнувши на кнопці   і тримаючи її 

вибрати інструмент-градієнт , ним провести через прямокутну область. 

Спробувати різні варіанти градієнта   та різні кольори 

заливки. 

17. Виділити прямокутну область, залити її кольором. Зменшити виділену 

область на 15 пікселів (пункт меню Виділення-Стиснути - задати15 px). 

Зменшений утворений прямокутник залити іншим кольором. 

Поекспериментувати зі збільшенням області виділення (Виділення-

Розширити) і зменшенням. 

18. Вирізати частину малюнку, відкинувши зайве за допомогою кадрування: з 

допомогою інструменту  виділити деяку область і натиснути Enter. 

Спробувати ще раз, але при цьому повернути область на 450 (клікнути за 

межами виділеного і тримаючи кнопку мишки потягнути курсор вверх або вниз) 

19. Для вибору певного попереднього кольору, що використовувався, можна 

скористатись інструментом , клікнувши ним на необхідному кольорі. 

20. Створити прапор України з аналогічними відтінками кольорів, що і 

попередній. 

21. Витерти частину малюнку, скориставшись резинкою , змінюючи 

ширину і форму резинки  спробувати ще раз.  

22. Збільшити та зменшити масштаб перегляду малюнку: вибрати  і клікнути 

декілька раз. Щоб зменшити масштаб треба клікнути, тримаючи кнопку Alt. 

23. Створити новий документ (Файл – Новий). Виділити прямокутну область і 

залити кольором ( ). Зняти виділення (Виділення – Прибрати 

виділення). Збоку, але так щоб елементи перекривалися, намалювати ще один 

прямокутник. 

24. Інструмент  використовується для виділення певного кольору. Взяти цей 

інструмент клікнути на кольорі одного з прямокутників, вибрати інший колір 

 та залити ним . 

25. З допомогою інструменту  виділити одну область прямокутника (з одним 

кольором). Тримаючи Shift клікнути на іншому кольорі, обидві виділені 

частини залити іншим кольором. 

26. Перемістити замальовані прямокутники. Виділити область  і  натиснути 

. 

27. Зменшити-скадрувати зображення так, щоб залишилися тільки замальовані 

прямокутники , вказавши розмір в пікселях( наприклад 800 пікс) і роздільну 

здатність зображення, яке отримаємо в результаті кадрування. 
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28. З допомогою інструменту  збільшити зображення в довжину. Для цього в 

опціях інструменту ширину і роздільну здатність вкажіть існуючу, а довжину 

більшу, наприклад на 600 пікселів.    

29. На панелі Історія при виконанні кожної дії з’являється новий рядок з назвою 

дії, клікніть на передостанньому рядку, щоб відмінити останню дію кадрування 

 

30. Вибрати інструмент . Він використовується для виділення довільної 

області. Клікнути за межами прямокутників, обвести контур навколо 

прямокутників, клікнути на початку контуру, тоді контур перетвориться у 

виділення. Перемістити виділену область . 

31. Намалювати знак 

 
 

32. Створити новий шар, використовуючи інструмент Прямокутник із 

заокругленими кутами (U), намалювати кнопку . 

Поекспериментувати із зміною кольору заливки, кольору і розміру контуру, кута 

заокруглення, довжини та ширини. Скопіюйте кнопку двічі. Для копіювання 

використовуйте Alt+рух вказівника миші. Зайдіть у панель шарів, виділіть три 

шари з кнопками, і об’єднайте їх у групу (Ctrl+G). Назву групи переіменуйте на 

“Кнопки меню”.   

33. Оберіть інструмент Прямокутник із заокругленими кутами (U), клікніть по 

шару із першою кнопкою, і дні неї змініть колір і розмір контуру. 

34. Шар із другою кнопкою растеризуйте. Дослідіть відмінності у роботі із 

шаруми з кнопками. 

35. Створити новий документ 50 см на 50 см 

36. Вибрати інструмент , клікнути на документі та ввести своє прізвище. 

Використовуючи інструмент  перемістити текст у верхню частину 

документу.  

37. Змінюючи колір та величину ліній  записати своє ім’я та 

по батькові. Звернути увагу, що кожен текстовий об’єкт знаходиться на окремих 

шарах. 

38. Задати іншу орієнтацію тексту ( клікнути на кнопці   і записати 

“Лабораторна робота”).  

39. Вибрати інструмент вводу тексту , у верхній панелі вибрати кнопку 

Деформація (вона дозволяє змінити стиль лінії). У вікні Деформація виберіть зі 

списку стиль, наприклад, Дуга і натиснувши Ок, напишіть ваше ПІБ. Вибираючи 

різні стилі та різні процентні відношення викривлення записати декілька слів 
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різної форми. Для завершення редагування тексту, клікніть на кнопку V, 

праворуч від кнопки Деформація 

40. Здійснити переміщення тексту . 

41. Створити новий документ. 

42. Вибрати інструмент . Вибрати на панелі  тип шрифту Курсив 

(Italic) і записати назву предмету.  

43. Змінити тип шрифту : напівжирний (bold), курсив (italic), 

напівжирний курсив (bold italic). Записати слова різними типами 

44. Документ зберегти під назвою 1.psd 

45. Створити документ 2.psd  – 500 пікселів на 500 пікселів. 

46. Залити документ кольором. 

47. Створити текстовий напис з власним прізвищем з розміром шрифта 150 px. 

48. Об’єднати фоновий шар (Background) з шаром, де знаходиться текст з 

прізвищем (клікнути на назві шару на панелі шарів (Layers) (у нижньому правому 

кутку екрана) і натиснути Ctrl+E або виконати команду Шар-Об'єднати з 

нижнім). 

 
 

49. З допомогою інструменту  клікніть на одній букві, вона виділиться, її 

залити іншим кольором. Аналогічно різними кольорами залити кожну букву. 

50. Зберегти під назвою 2.psd 

51. Перейти у файл із кнопками. У групі шарів під назвою “Кнопки меню” 

клікнути на верхній шар, вибрати інструмент , і підписати кожну кнопку на 

свій розсуд.  

52. Поміняти місцями шари так, щоб шар із текстом був над відповідним шаром 

із кнопкою.  Виділіть шар із кнопкою і відповідний шар із текстом і зв’яжіть 

виділені шари. Змініть їх розміщення. 

53. Створити новий документ. Залити певний кольором та вибравши 

інструмент олівець    вибрати зі списку Пензель:  , форма “зірочка” 

(або будь-яка інша) провести по всьому документу, заповнивши його. 

54. Вибрати інструмент . клікнути на документі із “зірочками” та набрати 

своє ім’я. Растеризувати даний шар і виділити букви з допомогою Чарівної 

палички.  На документі буде виділення у вигляді вашого набраного імені. 

Картинку під даним виділенням скопіювати (Редагувати- Копіювати ( Edit-Copy) 

або Ctrl+С. Перейти на документ 2.psd та вставити скопійований елемент 

https://drive.google.com/file/d/1GGPjQbNVOljh_WEZQccoIt1q4LatzX3p/view?usp=sharing
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(Редагувати-вставити або Edit-paste або Ctrl+V). Скопійований елемент 

розмістити під прізвищем . 

55. Вибравши інструмент  записати по батькові. Зайти в Шар - Стилі шару 

- Накладання візерунком, вибрати візерунок і ок. 

 

56. Створити напис “Я, <Ваше прізвище, ім’я, по батькові>” із будь-якого 

зображення (див. пункт 54) . Зображення можете взяти з галереї: Вікно-Більше-

Gallery. 

57. Здайте роботу в Google Class, відправивши посилання на папку з даною 

лабораторною роботою, яка має знаходитися на Вашому Google диску.  

 

 

Список рекомендованої літератури 

 

1. Дутчак М.С. Лекційний матеріал з дисципліни Web-дизайн. URL: 

https://drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-

ybqrjm62jQezKFC?usp=sharing 

2. Вивчіть Photopea. URL: https://www-photopea-

com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nu

i,elem 

  

  

Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
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Лабораторна робота 2. Корекція кольорів і ретушування зображень. 

Використання фільтрів.  

 

МЕТА: Ознайомлення із основними інструментами, необхідними при 

ретушуванні зображення; ознайомлення із основними засобами корекції 

кольорів. Набуття практичних навичок при корекції кольорів та ретушуванні 

растрових зображень. 

 

Хід роботи 

 

Увага!  

Папку цієї і кожної із наступних робіт теж створюєте на Google Drive 

у папці дисципліни і виконуєте в ній всі завдання відповідних робіт з 

допомогою web-версії додатку Photopea, періодично зберігаючи файли, а 

не шляхом завантаження файлів із локального ПК. ЗАВАНТАЖЕНІ 

ФАЙЛИ ІЗ ПК ПЕРЕВІРЯТИСЯ НЕ БУДУТЬ!!!  

 

Створіть папку lab2_lastname,  а в ній папку Файли для роботи, у яку 

скопіюйте всі заготовлені викладачем файли, які знаходяться у папці роботи 

lab2. Зробіть 4 копії документу 1.jpg (у контекстному документу оберіть 

«Зробити копію» ) і перенесіть їх у папку lab2_lastname, у якій 

перейменуйте ці файли відповідно на my11.jpg, my12.jpg, my13.jpg, my21.jpg.  

 

 

 Завдання 1: Забирання ефекту «червоних очей». 

Спосіб 1. 

1) Відкрийте файл my11.jpg. Збільшіть на екрані ділянку зображення, яка 

вимагає корекції. 

2) Виберіть інструмент Пензлик (Brush) з м’якими краями і розміром, який  

приблизно співпадає з розміром “червоних очей”. В якості кольору 

переднього плану виберіть чорний колір. Із списку Режим (Mode) панелі 

параметрів інструмента   Пензлик  виберіть елемент Color. 

3) При активізованому інструменті Brush клацніть на червоному кольорі очей 

декілька раз. В результаті червоний колір зникне, оскільки заданий режим 

змішування  дозволяє “змити” колір в тому місці, де ви клацнули мишкою. 

Збережіть файл під іменем my11.jpg. 

Спосіб 2. 

1) Відкрийте файл my12.jpg. Збільшіть на екрані ділянку зображення, яка 

вимагає корекції. 

2) Виділіть оба ока за допомогою довільних інструментів виділення (на свій 

вибір). 

Відкрийте вікно Відтінок/Насиченість (Hue/Saturation) (Для цього 

виконати Зображення-Корекція- Відтінок/Насиченість) 

3) За допомогою середнього повзунця зніміть насиченість зображення (задайте 

значення Насиченість (Saturation) мінус 100). 

https://drive.google.com/drive/folders/1b0c7NYoEa_aiJDBMVv9BpaotsLzT4llR?usp=sharing
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4) Зменшіть яскравість зображення за допомогою повзунця Яскравість 

(Lidhtness), змістивши його вліво. Зменшити яскравість потрібно таким 

чином, щоб новий колір зіниць (чорний) не контрастував із загальним 

зображенням). 

5) Збережіть файл під іменем my12.jpg. 

Спосіб 3. 

1) Відкрийте файл my13.jpg. 

2) З допомогою інструмента Червоні очі (J). 

3) Збережіть файл під іменем my13.jpg. 

 

 

Завдання 2: Зміна контрасту/ кольору частини зображення 

 

1) Відкрийте файл my21.jpg. Підніміть яскравість зображення на 5 одиниць, а 

контраст – на 10 (за допомогою меню Яскравість/Контраст 

(Brightness/Contrast) (Для цього виконати Зображення-Корекція- 

Яскравість/Контраст. 

2)  Виділіть блузку дівчинки та змініть тон зображення на рожевий: у вікні 

Відтінок/Насиченість (Hue/Saturation) повзунець Відтінок зсуньте вправо 

на 80. Увага! Слідкуйте, щоб виділення не зачепило фону. 

3) Аналогічно змініть тон бантів, підібравши його під колір блузки. 

4)  Збережіть файл під іменем my21.jpg. 

 

Завдання 3: відновлення частини зображення. 

1) Зробіть копію документу 2.jpg, перейменуйте її на my31.jpg  і перенесіть у 

папку lab2_lastname.  

2) Відкрийте файл my31.jpg. Внизу фотографії є написи. Ваша мета – забрати 

його з трави. 

Спробуйте використати інструмент Штамп (Clone stamp tools) із 

встановленим прапорцем Вирівнювання (Aligned) і без нього. Для того, щоб 

почати клонування частини зображення, клацніть мишкою в межах частини 

трави без надпису, утримуючи натиснутою клавішу Alt. Так задають точку 

відліку клонування. При неперервному перетягуванні мишки буде 

відбуватися неперервне перенесення клонованої частини зображення. 

Збережіть файл під іменем my31.jpg. 

 

Завдання 4: ретуш і корекція кольорового зображення. 

1) Зробіть копію документу 3.jpg, перейменуйте її на my41.jpg  і перенесіть у 

папку lab2_lastname.  

2) Відкрийте файл my41.jpg. Потрібно забрати акне (прищі) і пігментні плями 

(скористайтесь інструментом Латка у двох режимах: джерело і мета), 

освітлити ліву половину обличчя (інструмент Освітлювач), змінити колір 

головного убору на червоний (скористайтесь заливкою – для цього 

Толерантність встановіть 100, Непрозорість (Opacity) 30%). 

Збережіть файл під іменем my41.jpg. 
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Завдання 5: Використання фільтрів  

Створіть новий файл розміру А4, роздільної здатності 300 пікселі на дюйм: 

Файл - Створити - Друк- А4. Збережіть файл під назвою 5.1.psd.  

Відкрийте файл Eagl.psd.  

З допомогою інструмента Кадр, оберіть фіксований коефіцієнт  Ш: 4, В: 5, 

виділіть область на зображенні орла, яка б охоплювала всю ширину 

зображення, висота має бути меншою ніж висота зображення і клікніть Ок. 

Розмір результуючого зображення має бути 4х5 см, роздільна здатність 300 

пікселі на дюйм, перевірити так: Зображення - Розмір зображення. Виділіть 

все зображення. Скопіюйте зображення орла в щойно створений документ 

5.1.psd: Виділити - Все, Редагувати - Копіювати (Select all - Edit copy). 

Перейдіть у створений файл та виконайте команду Редагувати–Вставити 

(Edit - Paste). 

Закрийте файл Eagl.psd 

Виділіть зображення орла. Для цього не 

використовуйте інструмент прямокутного 

виділення, а зробіть це наступним способом: 

виділіть чарівною паличкою білий фон 

навколо зображення орла і виконайте команду 

Виділити – Інвертувати виділення (Select-

Inverse). Виберіть інструмент Переміщення 

 і утримуючи клавішу <Alt> перетягніть 

виділене зображення, утворіть 9 копій 

зображення орла та розмістіть їх по три копії 

у трьох рядках. Відстань між зображеннями 

встановіть по 1 см по боках і по 2 см зверху і 

знизу. Для вирівнювання фото використайте напрямні лінії. Для цього 

клікніть мишею на лінійці і утримуючи ліву клавішу миші, тягніть вказівник 

на малюнок. 

Перше зображення запишіть без змін. До наступних копій зображення 

застосуйте на свій вибір доступні фільтри ( під кожним малюнком 

підпишіть назву застосованого фільтру). Для цього необхідно виділити 

потрібне  зображення та виконати команду: Фільтр і обрати фільтр з 

переліку. Проекспериментувати з їх параметрами. Шари кожного ряду 

об’єднайте в одну груп, групи  назвіть: first row, second row, third row. 

 

Завдання 7: Створення маска відсікання (Clipping Mask). 

Зробіть копію документу Eagl.psd, перейменуйте її на myEagl.psd  і 

перенесіть її у папку lab2_lastname.  

Відкрийте файл myEagl.psd  

Додайте новий шар під зображенням орла і з допомогою інструмента 

“Еліпс” (U) намалюйте еліпс. 
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Дальше при нажатій клавіші Alt клікаєте на шар із орлом.  

В результаті ви отримаєте овальну форму для фото (маску відсікання), 

тепер спробуйте порухати шаром із орлом чи змінити його розмір 

(Alt+Ctrl+T), ефект має бути таким, ніби орел розміщений за вирізом 

овальної форми.    

Візьміть будь-які три СВОЇ фото, розмістіть їх поряд один з одним на різних 

шарах, накладіть на них маску відсікання у формі будь-яких трьох фігур. 

  

Завдання 8: Створення рамок 

1) Зробіть копію документу old.jpg, перейменуйте її на my_old.jpg  і перенесіть 

у папку lab2_lastname  

2) Відкрийте файл my_old.jpg.  

3) Виділіть прямокутну область  таким чином, щоб за межами області 

утворилась рамка шириною 1 см. 

4) Потім виконайте команду Виділення – Інвертувати виділення (Select-

Inverse). В результаті виділеною залишиться рамка зображення. 

5) Застосуйте Фільтр – Оформлення – Меццо-тінто (Filter-Pixelate-

Mezzotint). У вікні Меццо-тінто в полі Тип (Type) виберіть із списку тип 

оформлення рамки Хороші точки (Fine dots), Ок. 

 

6) Встановіть основний колір білий .  

 

7) Виконайте команду Редагувати-Обведення (Edit-Stroke), у вікні 

Обведення встановіть ширину обведення 1 пкс та Розміщення обведення 

рамки  – Всередині (Inside), Ок. 

8) Виконайте команду Виділення – Прибрати виділення (Select-Deselect, 

Ctrl+D).  

9) Збережіть файл. 

10) Здайте роботу, вказавши при здачі посилання на папку lab2_lastname. 

 

Список рекомендованої літератури 

 

1. Дутчак М.С. Лекційний матеріал з дисципліни Web-дизайн. URL: 

https://drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-

ybqrjm62jQezKFC?usp=sharing 

2. Вивчіть Photopea. URL: https://www-photopea-

com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nu

i,elem 

 

  

Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
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Лабораторна робота №3. Робота з текстом. Використання фільтрів 

 

МЕТА: Ознайомлення із основними параметрами та налаштуваннями 

інструмента  "Текст". Ознайомлення із основними фільтрами та їх параметрами.  

Набуття практичних навичок при написанні різних типів тексту та застосуванні 

до нього ефектів. 

 

 

Увага!  

Папку цієї і кожної із наступних робіт  теж створюєте на Google Drive у 

папці дисципліни і виконуєте в ній всі завдання відповідних робіт з допомогою 

web-версії додатку Photopea, періодично зберігаючи файли, а не шляхом 

завантаження файлів із локального ПК. ЗАВАНТАЖЕНІ ФАЙЛИ ІЗ ПК 

ПЕРЕВІРЯТИСЯ НЕ БУДУТЬ!!!  

 

 

 

Хід роботи 

 

Створіть папку lab3_lastname,  а в ній папку Файли для роботи, у яку 

скопіюйте всі заготовлені викладачем файли, які знаходяться у папці роботи lab3.  

 

Примітка: Якщо у Вашому графічному редакторі не можете знайти потрібні 

шрифти, фільтри, стилі, форми пензлів і т.д. спробуйте знайти їх у мережі Інтернет 

і встановити їх у Ваш графічний редактор, наприклад тут. Для цього у вікні 

відповідних інструментів шукаєте пункти на зразок: імпортувати, завантажити, 

встановити і вибираєте завантажений з мережі Інтернет файл. Якщо ви 

завантажили архівом, то його попередньо потрібно розархівувати. Зверніть увагу, 

що у вікні вибору файлу відображається потрібний формат для того чи іншого 

інструменту, крім того відкривається папка в якій графічний редактор шукає 

збережені файли. Знаходите Ваш завантажений файл із відповідним розширенням 

і клікаєте на кнопку “Завантажити (Імпортувати, Встановити і т.д.)”. 

Папка з деякими завантаженнями тут. 

Завдання 1. ТИТУЛЬНА СТОРІНКА 

1. Зробіть копію документу sky.jpg, перейменуйте її на my_sky.psd  і перенесіть 

у папку lab3_lastname.  

2. Відкрийте файл  my_sky.psd, змініть яскравість і контраст зображення так, 

щоб небо стало насичено блакитним. 

Скористайтеся меню Image>Adjustments>Brightness/Contrast (Зображення> 

Коригування> Яскравість / Котрастність). Збільшіть яскравість на 5, а 

контраст – на 40. 

3. За допомогою інструмента Текст  введіть текст  "Лабораторна (абзац) 

робота" з наступними параметрами: Шрифт – будь-який, що підтримує 

https://drive.google.com/drive/folders/1BD3BLbiF5UgcSRz-zKtMyU73BZYVaFHW?usp=sharing
https://www.brushlovers.com/
https://drive.google.com/drive/folders/19ZPIC_1XnPFoET_lO57zzen5LpPscGo3?usp=sharing
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кирилицю (у вікні вибору шрифтів поставте галочку біля Cyrillic), колір - 

Black, Розмір – на Ваш вибір, Форматування – по центру. 

4. Виділіть введений текст, клікнувши при нажатій клавіші Ctrl на мініатюру 

шару на панелі шарів. Перейдіть на шар з фоном (для цього на панелі шарів 

клацніть по його назві). Скопіюйте виділену область і вставте зображення. 

При цьому букви з фоновим зображенням перемістяться на новий шар. 

Якщо вставляються букви чорного кольору, а не з фоном зображення, 

закрийте око на шарі з текстом і повторіть копіювання і вставку. Щоб 

переконатися що текст вставився, закрийте око біля шару із фоном.  

5. Видаліть текстовий шар, створений у п. 3. 

6. Для шару з "фоновими буквами" задайте Шар → Стиль шару Outer Glow 

(Зовнішнє сяйво): Mode – Normal (Режим – звичайний), Size (Розмір) – 45, 

колір – жовтий. 

7. Введіть новий текст "виконав(ла)" з наступними параметрами: 

 Шрифт  – будь-який інший, що підтримує кирилицю, Розмір – 35, 

Форматування – по центру, Стиль спотворення по поверхні – Дуга (Зігнутий 

– 30).  

8. Для текстового шару "виконав (ла)" задайте стиль – Chromed Satin 

(Хромований атлас). Заданий стиль виберіть у вікні Style (Стилі), яке можна 

викликати з меню Windows (Вікно). 

 

 

 

9.  Поекспериментуйте із настройками даного стилю, відкривши діалогове 

вікно з ефектами шару, клікнувши на них у панелі шарів. Якщо даний стиль 

відсутній, завантажте його. Папка з деякими завантаженнями тут. 

10. Створіть два текстові шари (окремо) для тексту "студента" і "групи": Шрифт 

– Times New Roman, Розмір – 50, Форматування – по правому краю, Стиль  

– накладання візерунком, поекспериментуйте з параметрами. Для шару 

"групи" додайте підсвітку білим кольором (використайте стиль шару Outer 

Glow). 

11. Створіть вертикальний напис блакитного кольору з назвою своєї групи: 

Шрифт – Times New Roman, Розмір – 50, Форматування – по центру. 

Для даного шару задайте ефекти рельєфності: 

 

 

https://drive.google.com/drive/folders/19ZPIC_1XnPFoET_lO57zzen5LpPscGo3?usp=sharing
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Рисунок 3.1 – Стилі шару 

12. Підпишіть в одному текстовому шарі Прізвище, в новому рядку – Ім’я, в 

новому рядку – По-батькові. Розмір і тип шрифта підберіть самостійно, але 

так, щоб підпис був досить масивним. 

13. На основі щойно створеного шару  створіть підпис з фоновим зображенням 

аналогічно, як у п. 6. Видаліть текстовий шар із своїм прізвищем. Для 

растрового шару із своїм прізвищем задайте ефекти на вибір. 

14. Збережіть файл у форматі jpg. 

Примітка. Якщо в подальшій роботі немає  нагадувати про збереження 

файлів,  імена задавайте відповідно до номера завдання. 

Завдання 2.  НАПИС ВОГНЕМ 

Відеоінструкція тут 

1. Створіть файл розміром 1600х1000 px, dpi 72. При створенні зображення 

задайте колір фону чорним. Напишіть текст «Ваше_прізвище» (тут вказуєте 

Ваше реальне прізвище) білим кольором. Шрифт краще використовувати 

масивний. Якщо ви незадоволені розміром або розташуванням напису, то 

відредагуйте його. 

2. Закінчивши редагування тексту, растеризуйте його зробіть дублікат шару із 

тектом, верхній шар зробіть невидимим. закрийте овідкрийте палітру Layers 

(Шари).  

3. Поверніть зображення на 90° проти годинникової стрілки: Image ->Rotate 

Canvas >90 (Зображення> Трансформувати - Повернути на 90 градусів за 

годинникової стрілки). Застосуйте фільтр Wind (Вітер): Filter>Stylize>Wind 

(Фільтр>Стилізувати>Вітер). Саме для того, щоб застосувати даний фільтр, 

і необхідно було обертати зображення. Настройки фільтру встановіть 

наступні: Method (Техніка) - Wind або Blast, Direction (Напрям) - From the 

Left (Вітер зліва). Можна застосувати цей фільтр кілька разів, щоб 

збільшити язички полум'я.  

https://www.youtube.com/watch?v=P_alZWxcc4s
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4. Тепер поверніть зображення в початкове положення: Image > Rotate Canvas 

>90 (Зображення > Трансформувати - Повернути на 90 градусів проти 

годинникової стрілки). 

5. Щоб додати вогню плавні контури, розмийте текст. Використовуйте для 

цього фільтр Gaussian Blur: Filter >Blur >Gaussian Blur (Фільтр >Розмиття > 

Розмиття Гауса). У даному прикладі величина параметра Radius (Радіус) 

рівна 1 px. 

6. Ваше зображення містить три шари: фоновий шар і два шари з текстом. 

Зробіть дублікат шару із фоном, з’єднайте видимий шар з текстом із одним 

із фонових шарів. Layer >Merge Layers (Шар ->Об’єднати шари). Дайте 

йому назву Fire. 

7. До шару Fire застосуйте Фільтр -Пластика. Зліва виберіть перший зверху 

інструмент Розмазати, розмір- 40, густина -50, скорість 100. Повитягуйте 

“язики” вогню. 

8. Зараз вам слід пожвавити полум'я, додати йому рух. Для цього 

скористайтеся фільтром Ripple (Брижі): Filter >Distort > Ripple (Фільтр 

>Спотворення >Брижі). Візьміть середній розмір (Size Medium) і зробіть 

параметр Amount (Кількість) рівним 100. 

9. Тепер найцікавіше - розфарбовування полум'я. На шарі Fire, задайте 

Відтінок і Насиченість (Ctrl+U) з такими параметри: поставте відмітку біля 

розфарбувати, Відтінок - 40, Насиченість - 100, яскравість - 0. Знаходячись 

на шарі із Тоном і насиченістю, ще раз викликаєте Відтінок і Насиченість з 

такими параметрами: біля розфарбувати не має бути відмітки, Відтінок - -

15, Насиченість - 0, яскравість - 0. 

10.  До шару Fire застосуйте Рівні (Ctrl+L)  з такими параметри: нижнє 255 

змініть на 185. 

 
Рис.3.2 

11. Зробіть видимим верхній шар із текстом, назвіть його Текст. Для нього 

викличте Стиль шару - Накладання градієнту. Клікніть біля надпису 

градієнт, відкриється вікно Редактор градієнтів. Двіччі клікніть на правий 

нижній квадрат біля смуги з градієнтом і встановіть такі параметри кольору: 

H: 7, S: 100%, B: 27%, для правого нижнього:   H: 30, S: 95%, B: 96% і триччі 

Ок.  

12. Решту параметрів доробіть згідно Відеоінструкції. 

Результат представлений на рисунку 3.2. 

 

https://www.youtube.com/watch?v=P_alZWxcc4s
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Завдання 3. ПИШЕМО ЛЬОДОМ 

1. Створіть файл розміром 1600х1000 px, dpi 72. Колір фону встановіть білим. 

Напишіть чорними буквами текст «Ваше_прізвище» (тут вказуєте Ваше 

реальне прізвище). Шрифт краще вибрати масивний (внизу повинна 

залишитися відстань для бурульок). 

2. Відкрийте палітру Layer (Шар) і клацніть правою кнопкою миші по шару з 

текстом. У контекстному меню виберіть пункт Rasterize Layer 

(Растеризувати). З  цього  моменту ви можете застосовувати до тексту будь-

які інструменти редагування растрових зображень із стандартного набору.  

3. Оскільки крижана поверхня не ідеально гладка, треба додати їй шорсткість. 

Для цього додайте шум: Filter >Noise >Add Noise (Фільтр >Шум >Добавити 

шум). Задайте значення Amount (Кількість) рівним 70% і, найголовніше, 

встановіть прапорець Monochromatic (Монохромний, Одноколірний). 

4. Пом'якшимо ефект, одержаний при кристалізації і додаванні шуму за 

допомогою Фільтр > Розмиття > Розмиття Гауса, радіус розмиття - 2 рх. 

5. Зараз вам належить скористатися способом корекції кольорів. Виконайте 

команду: Filter >Blur > Blur (Фільтр > Розмивання> Розмивання). Тепер 

об’єднайте шари. Потім слід інвертувати зображення (для цього і 

знадобилося злиття шарів, оскільки подальші перетворення 

стосуватимуться не тільки тексту, але і фону). Виконайте команду Image > 

Adjustments> Inverse (Зображення >Коригування > Інвертувати (Негатив)) 

або Ctrl+I. 

6. Малюємо бурульки. Поверніть полотно на 90 градусів за годинниковою 

стрілкою, і скористайтеся можливостями фільтру  Wind (Вітер) справа. 

Тепер перевернемо полотно в початкове положення.  

7. Розфарбуємо лід. Виберіть команду меню Image >Adjustments 

>Hue/Saturation (Зображення > Коригування >Відтінок/Насиченість) або 

CtrL+U. Встановіть прапорець Colorize 

(Розфарбувати) і поекспериментуйте з 

різними настройками відтінку (Hue), 

насиченості (Saturation) і яскравості 

(Lightness), щоб вийшов блакитний колір, 

яким Вам підійде. Щоб підкреслити 

переходи в нерівностях поверхні, можете 

підправити контрастність зображення.  

13. Наприкінці, щоб лід заблищав і 

заіскрився, виберіть інструмент Brush 

(Пензлик), скористайтеся додатковими 

кистями у вигляді зірочок або сніжинок і активізуйте режим Яскраве світло 

для створення ефекту іскристого льоду, що переливається на сонці. Якщо у 

Вас немає потрібної форми пензля, можете її знайти в мережі Інтернет, а 

потім у вікні вибору форми вибрати Завантажити .ABR. клікнути на 

піктограму налаштувати (шестерня у правому верхньому куті) -> 

імпортувати пензлі.  

 

  

Рисунок 3.3 – Напис з льоду 
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Завдання 4.  КАМ'ЯНІ БУКВИ 

1. Створіть файл розміром 1600х1000 px, dpi 72. Виберіть чорний фон. 

Напишіть текст «Ваше_прізвище» (тут вказуєте Ваше реальне прізвище). 

Колір букв - близький до кольору букв на рис. 3.4. 

2. Переведіть ваш напис в растрове зображення.  

3. Виділіть букви за допомогою інструменту Magic Wand (Чарівна паличка) 

або при натиснутій клавіші Ctrl клікнути на міні-зображення на шарі з 

текстом. 

4. Потрібно спершу легко спотворити краї букв, щоб вони прийняли 

неправильну форму: фільтр Ocean Ripple (Океанські хвилі): Filter >Distort 

>Wave (Фільтр > Спотворення >Хвилі), значення параметрів настройки 

встановити min: 3,  до max 7, Number of Generators -1. 

5. Щоб згладити рвані краї, скористайтеся фільтром Crystallize 

(Кристалізація):Filter > Pixelate > Crystallize (Фільтр 

>Оформлення>Кристалізувати) Розмір осередку (Cell Size) виберіть з 

діапазону від 4 до 7.  

6. Зімітуйте фактуру шорсткої поверхні. Для цього можна скористатися 

фільтром Add Noise (Додати шум), параметр Amount (Кількість) 20-30. 

Обов'язково встановіть прапорець Monochromatic (Одноколірний, 

Монохромний), завдяки чому шум складатиметься з пікселів кольору, 

близького до кольору букв. 

 
Рис. 3.4. Фактура каменю 

Примітка: Зверніть увагу на те, що ваші букви як і раніше повинні 

залишатися виділеними, інакше шум накладатиметься не тільки на текст, 

але і на фон.  

7. Останній крок - формування структури тексту. Для цього перейдіть в Шар-

>Стилі шару->Параметри накладання -> Тиснення->Текстура. Виберіть 

візерунок найбільш схожий на камінь.  Поекспериментуйте з параметрами 

масштаб і глибина. Результат показаний на рисунку 3.4. 

 

Завдання 5.  

Заберіть фон, залишивши тільки зображення дівчинки із фото 1.jpg двома 

способами, наведеними нижче. 

 

Зробіть 2 копії документу 1.jpg і перенесіть їх у папку lab3_lastname, у якій 

перейменуйте ці файли відповідно на my51.jpg, my52.jpg, my53.jpg.  

 

Спосіб 1.  
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Відкрийте файл my51.jpg. Для видалення фону оберіть: «Виділити->Чарівне 

вирізання» (Зеленим кольором зафарбовуєте ту область, яка має 

залишилась, червоним ту, яку потрібно забрати). 

 

Спосіб 2. 

Відкрийте файл my52.jpg. На шарі із дівчинкою клікаєте на кнопку “Додати 

маску”, яка знаходиться під панеллю шарів: 

   
   

Вибираєте інструмент пензель круглої м'якої форми, якщо хочете щоб краї 

були розмиті, або жорсткої для чітких країв, клікаєте на мініатюру шару-маски на 

шарі із дівчинкою, при цьому основний колір має стати білим, а колір фону - 

чорним. Для встановлення вручну, клікніть клавішу D. 

Змініть основний колір на чорний (Х- міняє місцями основний і фоновий 

колір) і, знаходячись на мініатюрі шару-маски, видаляйте фон. Якщо видалили 

щось зайве, змінюєте основний колір на білий і відновлюєте зображення. Зверніть 

увагу, що на мініатюрі шару-маски білим кольором відображається те, що 

залишиться після застосування маски, а чорним - то що видалиться. Коли 

закінчили видалення фону, у контекстному меню мініатюри шару-маски 

вибираєте Застосувати маску шару.  

Результат збережіть під назвою my52.jpg 

 

Відкрийте файл my53.jpg, додайте маску до шару із дівчинкою, 

поекспериментуйте із зафарбуванням білим, чорним та різними відтінками сірого 

кольору, із різною жорсткістю, розміром та формою пензля, дослідіть доступні 

пункти контекстного меню мініатюри шару-маски. 

 

Список рекомендованої літератури 

 

1. Дутчак М.С. Лекційний матеріал з дисципліни Web-дизайн. URL: 

https://drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-

ybqrjm62jQezKFC?usp=sharing 

2. Вивчіть Photopea. URL: https://www-photopea-

com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nu

i,elem 

 

Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
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Лабораторна робота 4. Робота з шарами: зв’язування, стилі та ефекти 

шарів. Смарт-об’єкти. 

  

МЕТА:  Ознайомлення із роботою з шарами: створення, перегляд, 

зв’язування, стилі та ефекти шарів. Набуття практичних навичок при роботі з 

шарами, створенні стилів та застосуванні ефектів. 

 

 

Хід роботи 

 

Увага!  

Папку цієї і кожної із наступних робіт  теж створюєте на Google Drive 

у папці дисципліни і виконуєте в ній всі завдання відповідних робіт з 

допомогою web-версії додатку photopea.com, періодично зберігаючи файли, а не 

шляхом завантаження файлів із локального ПК. ЗАВАНТАЖЕНІ ФАЙЛИ ІЗ 

ПК ПЕРЕВІРЯТИСЯ НЕ БУДУТЬ!!!  

 

Створіть папку lab4_lastname, а в ній папку Файли для роботи, у яку 

скопіюйте заготовлені викладачем файли, які знаходяться у папці роботи lab4.  

 

Завдання 1: Намалювати планету 

1) Створіть новий файл розміром 500х500 пікселів з чорним фоном. 

2) Створіть новий шар і намалюйте круг за допомогою інструмента виділення 

“Вибір еліпсом” розміром приблизно 2/3 від площі малюнка (щоб виділяти кругом 

чи квадратом, робіть виділення із натиснутою клавішею Shift).  Залийте виділення 

чорним кольором (не забираючи виділення). Виберіть великий м’який пензлик  (з 

розмитими краями, жорсткість 0) діаметром 300 пікселів і встановіть наступні 

параметри пензлика: непрозорість – 30%, режим – Лінійне освітлення (Linear 

Dodge), колір – #664029. Замалюйте круг, як на малюнку: 

 

 

 

 

 

3) Створіть текстуру для планети, задавши властивості пензлика:  

Встановіть текстури для планети, наприклад із цього файлу чи будь які інші: 

https://drive.google.com/file/d/146Qo_B-HimM04Qn4-lPIr0L_LV4h0zs9/view?usp=sharing
https://drive.google.com/file/d/1k16qhw1DIDDKY4x-CKKiNCWrZyZvE5HJ/view?usp=sharing
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Тепер пензликом нанесіть текстуру на основну сферу, як показано на 

малюнку. Обов'язково залиште темну область — це тінь на планеті. (Пам'ятайте, 

що сфера повинна залишатися виділеною весь цей час)  

 

 

 

4) Тепер скористайтеся фільтром Сферизація.  

Фильтр  => Спотворення  => Сферизація (Filter > Distort > Sphereize) 

Виставте на 100% і натисніть на ОК, потім повторіть цю команду ще раз, але 

з показником 50%. Настав час позбутися зайвих пікселів по краях малюнка:  

Редагування > Вирізати (Edit > Cut) 

Вставте заготовку планети в новий прозорий шар.  

Редагування > Вставити (Edit > Paste) 
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Тепер треба додати планеті атмосферу. Здублюйте шар з планетою і для 

здубльованого шару: Шари => Стиль шару => Параметри накладання (Layer > 

Layer Style > Blending Options). 

Виберіть стиль шару — Зовнішнє сяйво (outer glow), режим – лінійне 

освітлення, Непрозорість (Fill Opacity) — 100%,  колір (set color of glow) — 

#6283A7, размір (size) – 15 px. 

Виберіть ефект шару — Внутрішнє сяйво (inner glow), Непрозорість (Fill 

Opacity) — 100%, колір — #6283A7, размір – 70 px. 

Тепер у вас є шар з атмосферними ефектами. Перетворіть цей шар у смарт-

об’єкт. Для чого виконайте Шар -> Смарт-об'єкт -> Перетворити на смарт об'єкт. 

Після чого растеризуйте шар з атмосферою:  Шар -> Растеризувати. 

 

 

 

6) Виберіть інструмент Гумка (eraser tool). Виставте діаметр 300 пікселів, 

жорсткість 0%. І зітріть атмосферу так, як показано на малюнку.  

 

 

 

Тепер ваша планета виглядає майже як справжня. Зв’яжіть шари: виділіть 

активний шар з ефектами і шар з планетою без ефектів і виконайте об’єднання 

Шар  => Виконати зведення (Layer > Marge Layers) або через контекстне меню 

шару на панелі шарів. 

 

Завдання 2. Створіть презентацію дизайну сайту за допомогою смарт-

об'єктів. 

 

Створити копію файлу Mockup-for-web-designers.psd, перенести її у папку 

lab4_lastname i перейменуйте на  My-Mockup-for-web-designers.psd. У кожній із 

панелей з допомогою смарт-об'єктів презентуйте як мінімум три варіанти дизайну 

сайту: перший - згідно вашого порядкового номеру у списку групи, другий - 
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наступний номер після вашого варіанту, третій - будь-який на ваш вибір із цієї 

PSD.  

Виділити шар Front -> у контекстному меню вибрати “Перетворити на смарт-

об'єкт” -> двічі клікнути по квадрату у нижньому правому куті -> у новостворений 

файл вставити зображення  трьох варіантів дизайну головної сторінки -> Файл- 

Зберегти (Смарт-об'єкт). 

Те саме проробити із панелями Left 1 i Right 1, при цьому варіанти дизайну 

решту сторінок пристосувати до цих панелей: Редагувати - Трансформувати - 

Спотворити. 

 

Завдання 3. У файлі My-Mockup-for-web-designers.psd у панелі шарів перед 

папкою Group створіть папку Tree, а в ній два нових шар. На кожному із них з 

допомогою форми пензля “дерево” (якщо немає, можете доставити або 

використати будь-які доступні форми), створіть два різні зображення дерева. 

Перетворіть їх по черзі на смарт-об’єкти і з допомогою смарт-об'єкта задайте 

мінімум два альтернативних зображення для кожного із дерев. 

Зверніть увагу, що додані у смарт-файл зображення мають мати форму 

дерева. Для цього, знаходячись на шарі із деревом, виділіть все, що знаходиться 

за його межами, перейдіть на шар із вставленим зображенням і клікніть на клавішу 

Del, має залишитися зображення у формі дерева, далі Файл- Зберегти (Смарт-

об'єкт). 

Список рекомендованої літератури 

 

1. Дутчак М.С. Лекційний матеріал з дисципліни Web-дизайн. URL: 

https://drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-

ybqrjm62jQezKFC?usp=sharing 

2. Вивчіть Photopea. URL: https://www-photopea-

com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nu

i,elem 

 

  

https://drive.google.com/drive/folders/13nwyldiziJW2wX5QK1hM8P64l2Wjn_vg?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
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Лабораторна робота 5. Основи роботи У векторному онлайн-сервісі розробки 

інтерфейсів та прототипування figma.com 

Увага!  

 Всі завдання, які потрібно виконувати з допомогою web-сервісу figma.com, 

повинні виконуватися безпосередньо онлайн, а не шляхом завантаження 

файлів із локального ПК. 

1. Подайте заявку на безкоштовне користування онлайн-сервісом Figma.com 

за посиланням: https://www.figma.com/education/apply. Оберіть вхід через Google 

account, далі виберіть обліковий запис на домені pnu. Вкажіть свій статус як 

студент, ціль запиту на безкоштовне використання (I want to familiarize myself with 

the online service Figma.com чи щось таке), заповніть наступні поля:  

 

Назвіть команду своїм прізвищем та іменем на анг. мові, скопіюйте посилання на 

запрошення в команду (його пізніше вкажете при здачі роботи) і запросіть 

mariia.dutchak@pnu.edu.ua у команду. 

https://www.figma.com/education/apply
mailto:mariia.dutchak@pnu.edu.ua
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2. Далі оберіть план Professional, для користувачів освітніх закладів він 

безкоштовний. 
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3. Ознайомтесь із основами роботи у онлай-сервісі Figma.com і виконайте дії, 

які проілюстовані у вказаних 4-х відео за посиланнями: 

 

▶️ Beginner 1: Explore ideas 

▶️ Beginner 2: Create designs 

▶️ Beginner 3: Build prototypes 

▶️ Beginner 4: Prepare for handoff 

4. Здайте роботу, вказавши посилання на виконаний проект (1, 3 на рисунку 

нижче), перевірте чи ви додали до проекту обліковий запис 

mariia.dutchak@pnu.edu.ua з правами редагування (2 на рисунку нижче). 

https://help.figma.com/hc/en-us/sections/4405269443991-Figma-for-Beginners-4-parts-
https://help.figma.com/hc/en-us/articles/4405269899287--Beginner-1-Explore-ideas
https://help.figma.com/hc/en-us/articles/4405328886935--Beginner-2-Create-designs
https://help.figma.com/hc/en-us/articles/4405337257751--Beginner-3-Build-prototypes
https://help.figma.com/hc/en-us/articles/4405338399895--Beginner-4-Prepare-for-handoff-
mailto:mariia.dutchak@pnu.edu.ua
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Список рекомендованої літератури 

 

1.  Beginner 1: Explore ideas. URL: https://help.figma.com/hc/en-

us/articles/4405269899287--Beginner-1-Explore-ideas 

2.  Beginner 2: Create designs. URL: https://help.figma.com/hc/en-

us/articles/4405328886935--Beginner-2-Create-designs 

3.  Beginner 3: Build prototypes. URL: https://help.figma.com/hc/en-

us/articles/4405337257751--Beginner-3-Build-prototypes 

4.  Beginner 4: Prepare for handoff. URL: https://help.figma.com/hc/en-

us/articles/4405338399895--Beginner-4-Prepare-for-handoff- 

  

https://help.figma.com/hc/en-us/articles/4405269899287--Beginner-1-Explore-ideas
https://help.figma.com/hc/en-us/articles/4405328886935--Beginner-2-Create-designs
https://help.figma.com/hc/en-us/articles/4405337257751--Beginner-3-Build-prototypes
https://help.figma.com/hc/en-us/articles/4405338399895--Beginner-4-Prepare-for-handoff-
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Лабораторна робота 6. Створення ескізу сайту засобами онлайн-сервісу 

figma.com 

Увага!  

 

Не забувайте, що всі завдання, які потрібно виконувати з допомогою web-

сервісів photopea.com та figma.com, повинні виконуватися безпосередньо в них 

онлайн, а не шляхом завантаження файлів із локального ПК. 

ЗАВАНТАЖЕНІ ФАЙЛИ ІЗ ПК ПЕРЕВІРЯТИСЯ НЕ БУДУТЬ!!!  

 

 

1. У папці дисципліни на Google Drive створіть папку lab6_lastname, у яку 

збережіть готовий PSD шаблон (template) веб-сайту згідно Вашого варіанту 

і проаналізуйте його структуру, вмістиме шарів, стилі елементів і т.д. з 

допомогою ГР Photopea,  “Ctrl + ;” - показати/приховати направляючі. 

2. У папці лабораторної роботи створіть Google документ description_A.docx, 

де А- номер варіанту, в якому опишіть всі основні характеристики шаблона: 

● основні кольори, 

● розміри сітки, 

● опис типографіки, яку використано: шрифти, їх кольори і розміри, 

міжрядковий інтервал тощо, 

● при потребі можете додати в опис елементи, які можуть викликати 

сумніви у верстальника, наприклад, скріншоти станів інтерактивних 

елементів з описом анімації. 

● опис базових елементів і так далі. 

3. З допомогою онлай-сервісу Figma.com відтворіть по максимуму графічний 

шаблон згідно вашого варіанту, розбивши його на кілька логічних сторінок 

і встановивши між ними зв'язки і анімовані переходи (див. Відео 3 із 

попередньої роботи).  Графічний шаблон обов'язково відтворіть на рівні 

ескізу.  

 

Зверніть увагу, що пункти меню на головній сторінці можуть не мати 

відповідних вебсторінок у графічному макеті, тому орієнтуйтеся на 

сторінки, які ви зможете виділити із PSD шаблону, і для них задайте пункти 

меню чи кнопки для переходу на них.  

 

https://drive.google.com/drive/folders/13nwyldiziJW2wX5QK1hM8P64l2Wjn_vg?usp=sharing
https://www.figma.com/
https://help.figma.com/hc/en-us/articles/4405337257751--Beginner-3-Build-prototypes
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4. Здайте роботу, вказавши посилання на виконаний проект (1, 3 на рисунку 

нижче), перевірте чи додано до проекту обліковий запис 

mariia.dutchak@pnu.edu.ua з правами редагування (2 на рисунку нижче). Якщо ні, 

додайте 

mailto:mariia.dutchak@pnu.edu.ua
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Список рекомендованої літератури 

 

1.  Beginner 1: Explore ideas. URL: https://help.figma.com/hc/en-

us/articles/4405269899287--Beginner-1-Explore-ideas 

2.  Beginner 2: Create designs. URL: https://help.figma.com/hc/en-

us/articles/4405328886935--Beginner-2-Create-designs 

3.  Beginner 3: Build prototypes. URL: https://help.figma.com/hc/en-

us/articles/4405337257751--Beginner-3-Build-prototypes 

4.  Beginner 4: Prepare for handoff. URL: https://help.figma.com/hc/en-

us/articles/4405338399895--Beginner-4-Prepare-for-handoff- 

  

https://help.figma.com/hc/en-us/articles/4405269899287--Beginner-1-Explore-ideas
https://help.figma.com/hc/en-us/articles/4405328886935--Beginner-2-Create-designs
https://help.figma.com/hc/en-us/articles/4405337257751--Beginner-3-Build-prototypes
https://help.figma.com/hc/en-us/articles/4405338399895--Beginner-4-Prepare-for-handoff-
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Лабораторна робота 7. Створення анімацій 

 

Увага!  

 

Не забувайте, що всі завдання, які потрібно виконувати з допомогою web-

сервісів photopea.com та figma.com, повинні виконуватися безпосередньо в них 

онлайн, а не шляхом завантаження файлів з локального ПК. ЗАВАНТАЖЕНІ 

ФАЙЛИ З ПК ПЕРЕВІРЯТИСЯ НЕ БУДУТЬ!!!  

 

 

Завдання 1. Створити анімацію “Вогонь” з допомогою онлайн-додатку 

photopea.com згідно інструкції: 

1. Створюємо новий документ з розміром 600х200px, DPI 72, і заливаємо 

його чорним кольором. Створюємо новий шар і переходимо на нього. Тепер 

вибираємо інструмент Вибір прямокутником (М) і виділяємо нижню частину 

документа, ось так : 

 
 

і заливаємо виділене білим кольором. Після чого знімаємо виділення натиснувши 

Ctrl+D. 

2. Далі клікаємо Фільтр > Размиття > Размиття Гауса, і застосуємо 

значення 10-15 px. 

 
3. Тепер продублюємо шар 3 рази, і вимкнемо видимість шарів так як на малюнку, 

активувавши при цьому лише 1 шар:  
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4. Далі вибираємо інструмент Палец. Задаємо параметри як на малюнку: 

 

Створюємо ефект вогню і його напрям : 

 
5. Продовжуємо ефект по довжині нашого документа, при цьому змінюючи розмір 

інструмента Палец, для більш реалістичного вигляду 

 

 

6. Робимо цей шар невидимим і переходимо на другий шар. Повторимо 

виконання як з першим шаром, при цьому намагаючись зберегти ту саму висоту 

вогню: 

 

 
7. Виконаємо те саме з наступними шарами, не забуваючи робити попередній 

шар невидимим. 

Далі виділяємо ці чотири шари, заходимо в Шар -> Анімація ->Make Frames. 

Початок назви кожного слою має змінитися на  _a_.   
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9. Залишилось лише додати колір нашому вогню. Вибираємо під списком 

шарів Новий шар корекції-> баланс кольорів: 

 

 

 
 

Застосовуємо такі параметри: 

Тіні: [ +60 ] [ 0 ] [ -15 ] 

Напівтони: [ +100 ] [ 0 ] [ -30 ] 

Світлі тони : [ +50 ] [ 0 ] [ -30 ] 

 

Для перегляду і збереження анімації Файл -> Експортувати як -> Gif. Тут на 

свій розсуд змініть швидкість зміни слоїв, кількість повторів залиште 0 - 

безперервне повторення. 

 

Завдання 2. Створити анімації з допомогою онлайн-сервісу figma.com відповідно 

до наступних відео:  

- Реакція на подію 

- Безперервна анімація 

Ctrl+D - дублікат фрейму. 

 

Експортуйте створену анімацію у gif-файл.  

Для експорту анімації із figma.com у gif-файл встановіть плагін Export to 

GIF/Video: Main menu - Plugins - Fine more plugins… 

Щоб запустити плагін, викличте контекстне меню для фрейму із анімацією, у 

ньому виберіть Plugins - Export to GIF/Video  

- Анімації 

https://drive.google.com/file/d/1TCN7BcZQxdqs_NBGsn70NZ1LnzM6zpb5/view?usp=sharing
https://drive.google.com/file/d/1613FrKeVGK8eJLyy2TYFGVtrbl1-d2rp/view?usp=share_link
https://www.youtube.com/watch?v=0047qy7XHzI
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На місці анімації із цього відео (там де автор викладає ролики із собою), 

використовуйте будь-який gif-файл, в тому числі щойно створений.  

Завдання 3. Здати роботу, вказавши посилання на папку, які містить анімації, 

створені з допомогою  photopea.com і посилання на анімації, створені з допомогою 

figma.com. Перевірте чи додано до figma-проекту обліковий запис 

mariia.dutchak@pnu.edu.ua з правами редагування. Якщо ні, додайте. 

 

 

Список рекомендованої літератури 

 

1. Дутчак М.С. Лекційний матеріал з дисципліни Web-дизайн. URL: 

https://drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-

ybqrjm62jQezKFC?usp=sharing 

2. Вивчіть Photopea. URL: https://www-photopea-

com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nu

i,elem 

 

  

mailto:mariia.dutchak@pnu.edu.ua
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
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Лабораторна робота 8. Розробка бріфу на дизайн сайту 

ЗАВДАННЯ 

1.  У папці дисципліни на Google Drive створіть папку lab8_lastname. 

2. У папці лабораторної роботи lab8_lastname на Google Drive створіть файл 

zvit8.docx . У ньому виконуйте вказані нижче завдання. ЗАВАНТАЖЕНИЙ 

З ПК ЗВІТ ПЕРЕВІРЯТИСЯ НЕ БУДЕ!!! 

3. Опрацюйте теоретичний матеріал Лекції 3.   

4. Перед складанням бріфу (технічного завдання) (див. наступне завдання), 

проведіть аналіз аналогічних сайтів чи сайтів конкурентів і відобразіть 

процес (скріни екранів) та результати аналізу у звіт. Ви маєте розробити 

бріф для сайту “Особиста сторінка-портфоліо студента-програміста”, 

відповідно конкурентами будуть подібного типу сайти. Кількість 

досліджуваних сайтів повинна бути не меншою 2. Зразок аналізу сайтів 

конкурентів наведено в Додатку 1.  

Проаналізуйте і зобразіть чи опишіть наступне: 

o структуру сайту, представлення структури в меню; 

Зобразіть структуру одного із сайтів у вигляді дерева, а іншого - у 

вигляді ментальної карти. Можете скористатися однією із програм 

для побудови mind-map. Запишіть у звіт як представлена структура 

в меню. 

o інформацію, наведену на головній сторінці; 

o прототип головної і другорядних сторінок; 

o зміну відображення елементів веб сторінки на різних пристроях 

виводу; тип верстки: фіксована, гумова чи адаптивна, достатню / 

недостатню наявність порожнього простору; 

o використані шрифти; 

o кольори сайту, доречність колірної гами для даної тематики; 

o графічні елементи, відповідність їх тематиці сайту; 

o емоційний вплив сайту. 

Для дослідження можете скористатися панеллю DevTools браузера Google 

Chrome. Її можна викликати клікнувши на пункт “Перевірити” контекстного 

меню вікна браузера. Вибравши елемент на веб сторінці, у закладці  Style 

(2) вкладки “Elements” (1) можна подивитися застосовані стилі, в тому числі 

назви шрифтів (властивість: font-family (3)). 

Дослідити відображення елементів веб сторінки на різних пристроях 

виводу, можна клікнувши на Toggle device toolbar (4). Вверху над веб 

https://docs.google.com/document/d/1u9skjLRYoYwC4q0ZQdhNKWJljCnAmVhZ/edit?usp=sharing&ouid=109219261408206469601&rtpof=true&sd=true
https://sites.google.com/site/wwwmindmupua/programi-dla-pobudovi-mind-map
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сторінкою появиться смужка із поділками для різних пристроїв виводу і 

розмірів екрану в пікселях (5). Клікніть на них, подивіться як змінюється 

розташування елементів на сторінці. 

Для зміни розташування панелі DevTools, в її правому верхньому куті 

клікніть на вертикальні три крапки (6). 

 

 

Для перегляду контрольних точок медіа запитів, ввімкніть “Show media 

queries” (7), яка знаходиться  

5. Чи є у розглянутих вами сайтів загальні елементи? 

6. Складіть бріф (технічне завдання) на розробку веб-дизайну сайту на тему 

“Особиста сторінка-портфоліо студента-програміста ” на основі зразка, 

наведеного в Додатку 2 до роботи 

 

Вимоги до сайту: 

Сайт “Особиста сторінка-портфоліо студента-програміста”   

Мета створення сайту: 

Розміщення особистих даних: ПІБ, контакти, презентація професійних навиків та 

створених проектів, профорієнтаційна робота серед учнів старших класів, 

розміщення цікавої та актуальної текстової, графічної чи відео інформації 

(посилання на відео в youtube) з професійної та будь-якої іншої тематики, в тому 

числі про Ваше хоббі для залучення відвідувачів на сайт, наприклад з метою 
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популяризації та просування Вас як професіонала-програміста чи просто цікавої 

людини, чи, можливо, з метою отримання коштів за розміщену на вашому сайті 

рекламу, і т.д. 

Мінімальна інформація на сайті: 

➢ ПІБ, коротко про себе, контакти, поля для відправлення запитань, 

відгуків і пропозицій.  

➢ Професійні інтереси: що вмієте і який напрям інженерії програмного 

забезпечення для Вас найбільш цікавий, в якому напрямку Ви б хотіли 

працювати і розвиватися; представлення Ваших робіт і проектів (тут можете 

вказати стартову сторінку веб-хостингу із переліком Ваших робіт). 

➢ Хоббі, будь-яка інша науково-популярна тематика у вигляді блогу, 

фотогалереї, цікавих матеріалів чи корисних посилань і т.д. 

➢ Профорієнтаційна сторінка: чому я обрав спеціальність 121 ІПЗ, 

презентація спеціальності з метою залучення абітурієнтів.       

➢ Актуальні новини та тренди для програміста, погруповані по 

напрямах. Наприклад з веб-дизайну, веб-розробки, аналізу даних, 

програмування мобільних застосувань і т.д.  

➢ Корисні посилання і короткі їх описи з професійної тематики, 

наприклад на довідники, сайти-помічники, сайти-репозиторії, сайти із 

оголошеннями про пошук роботи та наявні вакансії  і т.д. 

➢ Банери з анонсами актуальних подій: різноманітних заходів, 

воркшопів, семінарів, конференцій і т.д.; рекламні банери; нші на Ваш 

вибір. 

➢ Форум за тематиками. 

➢ Відповіді на найбільш часті питання. 

➢ Решта інформація та сторінки на Ваш вибір.  

➢ Пошук по сайту 
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Додаток 1.  

Огляд сайтів конкурентів (не менше 2-х!) 

  

1. Назва компанії (установи, сайту) і URL сайту 

 

Скріншот головної сторінки, <16:07 05/04/2023 - час і дата звернення> 

 

 

Інформація 

на головній 

сторінці: 

1. Новини 

2. Контакти 

….. 

Структура 

сайту: 

Головна 

1. послуги 

a. розробка дизайну 

b. інтер'єрний друк 

c. офсетний друк 

d. цифровий друк 

2. Продукція і ціна 

a. візитки 

b. пластикові карти (New!) 

c. буклети та брошури 

d. листівки 

e. календарі 

f. меню 

g. плакати 

h. конверти 

i. запрошення 

j. Листівки 

k. магніти 

l. папки та коробки 

m. для весілля (New!) 

3. Галерея наших робіт 

4. Контакти 

a. Карта проїзду 

b. Про нас 

5. Вітання 

Верстка: Адаптивна, невелика кількість контенту на сторінках сайту 

вдало вписується в даний тип верстки. 
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Макет 

(прототип) 

головної 

сторінки 

 
Макети 

(прототипи) 

другорядних 

сторінок 

 
Використані 

шрифти 

назви, стилі шрифтів 

Кольори: Кольори сайту:  ..., що добре підходить/не підходять по тематиці 

сайту. 

Графічні 

елементи: 

….. (Не) Відповідають тематиці сайту. 

Емоційний 

вплив сайту: 

Динамічний дизайн, що викликає відчуття, що …... 

Зауваження: Важко знайти вимоги до макетів. 
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Додаток 2. 

БРІФ  

на разработку дизайну сайта 

 

1  Назва компанії (ПІБ студента):   

2  Назва сайту:   

3  Адреса для розміщення виконаних 

завдань: 

  

4  

Завдання розробника: 

1. Розробка фірмового стилю. 

2. Розробка дизайну головної і 

другорядної сторінок сайту. 

 

5  Мета створення сайту:   

6  Сфера діяльності:   

7  Цільова аудиторія :   

8  На які географічні регіони повинен 

бути орієнтований сайт: 

  

9  Мовні версії сайту:   

10  
Сайти конкурентів: 

Зразок аналізу сайтів конкурентів 

наведено в Додатку 1.  

11  Матеріали, надані замовником:   

12  

Структура сайту: 

1. Про компанію (Про мене) 

2. Новини 

3. … 

4. Інші 

13  Компоненти сайту (про компанію 

(про мене), новини, анкетування, 

інтернет-магазин, банерна реклама, 

лічильники відвідувань, відгуки і 

пропозиції, контакти ін.): 

  

14  Колірна гамма сайту:  Згідно розробленого фірмового стилю 

або  вказати корпоративні кольори 
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15  Що в результаті 

відвідування 

сайту користувач 

повинен 

побачити:  

зробити  

відчути:  

16  Вид верстки 

(фіксована/гумова/адаптивна): 

адаптивна 

17  Ширина веб-сторінки: 1) Монітор …. px 

2) Планшет з альбомною орієнтацією  

…. px 

3) Планшет з книжковою орієнтацією ... 

px 

4) Смартфон з книжковою орієнтацією 

... px 

 

Обов’язково розробіть для екранної і 

мобільної версії сайту, для планшетної 

за бажанням) 

18  Графік робіт: 1. Аналіз сайтів конкурентів: 

23/04/202_ (lab8) 

2. Фірмовий стиль (вибір кольорів, 

шрифтів, стилю, іконки, розробка 

логотипу, gif-анімації, рекламного 

героя, і т.д.): 21.05.202_ (lab9) 

3. Структура вебсайту у вигляді  

дерева або ментальної карти. 

Прототипи головної та 

другорядних сторінок. Вихідний 

контент (тексти, фото, тощо): 

21.05.202_ (lab10) 

4. Ескізи головної та другорядних 

сторінок для різних пристроїв 

виводу: 21.05.202_ (lab11) 

5. Фінальні графічні макети 

вебсторінок: 21.05.202_ (lab12) 

6. Створення адаптивних веб-

шаблонів сторінок з допомогою 

CSS Grid: 21.05.202_ (lab13) 

 

Увага! Лабораторні роботи 9-13 

можете робити паралельно у 

зручному для Вас порядку, вносячи 
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зміни у відповідні файли та папки 

робіт. 

19  Бюджет замовлення:  0 грн 

 

 

 

Замовник: 

Дутчак М.С., викладач 

кафедри інформаційних технологій 

mariia.dutchak@pnu.edu.ua 

Виконавець проекту : 

ПІБ студента, студент 

гр. ІПЗ-1х 

email@gmail.com 

  

   

__ лютого 202_ р. 

 

КОНТРОЛЬНІ ПИТАННЯ 

1. Що таке бріф / ТЗ? 

2. Які основні функції бріфа / ТЗ? 

3. Які основні етапи створення дизайну сайту? 

 

Список рекомендованої літератури 

 

1. Дутчак М.С. Лекційний матеріал з дисципліни Web-дизайн. URL: 

https://drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-

ybqrjm62jQezKFC?usp=sharing 

2. Вивчіть Photopea. URL: https://www-photopea-

com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nu

i,elem 

  

Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
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Лабораторна робота 9. Розробка елементів фірмового стилю 

 

Увага!  

 

Всі лабораторні роботи, починаючи із цієї, можете виконувати паралельно у 

зручному для Вас порядку, вносячи зміни у відповідні файли та папки робіт.  

 

Також не забувайте, що всі завдання, які потрібно виконувати з допомогою 

web-версії додатку photopea.com, повинні виконуватися безпосередньо у на 

вашому Google Drive, періодично зберігаючи файли, а не шляхом 

завантаження файлів із локального ПК. ЗАВАНТАЖЕНІ ФАЙЛИ ІЗ ПК 

ПЕРЕВІРЯТИСЯ НЕ БУДУТЬ!!!  

 

 

1. Розробити фірмовий стиль свого персонального сайту. Фірмовий стиль 

повинен включати в себе наступні елементи: 

o Логотип. Логотип створіть в трьох варіантах: фірмовий знак з 

текстом внизу, фірмовий знак з текстом справа, логотип в 

ахроматичних кольорах. Логотип повинен бути масштабованим, 

компактним і ілюстративним. 
o Анімований циклічний логотип (рекламний банер) у форматі gif 

з можливістю його перегляду через веб. 
o Шрифти. Підібрати два види шрифтів: для основного тексту та 

заголовків. 
o Кольори. Вибрати базові кольори у відповідність з деякою колірною 

гармонією (наприклад, монохромною, аналоговою, 

комплементарною та ін.) 
o Іконки, кнопки 

2. У папці з лабораторною роботою створіть  файл CompanyStyleLastname.psd, у 

якому розмістіть елементи фірмового стилю  згідно із зразком: 
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3. На веб хостингу у папці з номером даної лабораторної роботи також  

створіть  файл lab9Lastname.html,  у якому відобразіть вмістиме файлу 

CompanyStyleLastname.psd, а також анімований логотип (рекламний банер).  

Сторінку із презентацією елементів фірмового стилю зверстайте з 

допомогою CSS Grid.  Варіанти логотипу вставте як три різні картинки.  

Посилання на стартову сторінку веб-хостингу із посиланням на дану роботу 

вкажіть при здачі цієї роботи. У майбутньому на веб-хостингу потрібно буде 

ще розмістити посилання на 13 лабораторну роботу. 

Приклад створення квадрату із кольором і підписом до нього:  

<div>  

<div style="width:20px; height: 20px; background: #8600af; "> </div> 

<p style=" font-size: 12px;"> RGB(134,0,175)</p> 

</div> 

4. Вигляд шрифту задайте з допомогою  CSS-властивостей, які можна 

подивитися на панелі CSS photopea.com, клікнувши на потрібний шар із 

текстом: 

https://docs.google.com/document/d/1tmwsZpuvIVcoq6slWhuJLtpj24OBJ9s0/edit?usp=sharing&ouid=109219261408206469601&rtpof=true&sd=true
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А потім ці стилі задати для потрібного абзацу, наприклад так: 

<p style="font-size: 27px; color: #090909; font-weight: 700; font-family: 

'Caveat';">  

    a b c d e f g h i j k l m n o p q r s t u v w x y z <br> 

    A B C D E F G H I J K L M N O P Q R S T U V W X Y Z <br> 

    а б в г ґ д е є ж з и і ї й к л м н о п р с т у ф   х ц ч ш щ ь ю я <br> 

    А Б В Г Ґ Д Е Є Ж З И І Ї Й К Л М Н О  П Р С Т У Ф Х Ц Ч Ш Щ Ь Ю 

Я<br> 

    1234567890 </p> 

Якщо потрібний Вам шрифт відсутній на ПК, можете його завантажити із 

сайту https://fonts.google.com/.  

Для цього у полі Search fonts введіть назву потрібного шрифту або виберіть 

із запропонованого переліку і клікніть на Download family (1). Для 

встановлення потрібного шрифту на ПК, розархівуйте завантажені файли і 

викличте контекстне меню для файлу із розширенням ttf, далі Встановити. 

Для того, щоб шрифт заданий на вебсторінці, яка розміщена на вебхостингу, 

коректно відображався на будь-якому пристрої, незалежно від встановлених 

на ньому шрифтів, підключіть до вебсторінки потрібні шрифти. Для цього 

клікніть на “+ Select this style”  біля необхідного Вам вигляду шрифту, далі 

скопіювати і вставити в заголовок веб-сторінки необхідний код (2)     

https://fonts.google.com/
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Приклад підключення шрифту: 

 <style> 

@import url('https://fonts.googleapis.com/css2?family=Caveat&display=swap'); 

</style> 

Також шрифти можете підключити з допомогою правила @font-face (див. відео 

Підключаємо шрифти). Даний спосіб є кращим з точки зору швидкості 

завантаження сторінки.  

@font-face { 

  font-family: 'MyWebFont'; 

  src: url('myfont.woff2') format('woff2'), 

       url('myfont.woff') format('woff'), 

       url('myfont.ttf') format('truetype'); 

} 

 

body { 

  font-family: 'MyWebFont', Fallback, sans-serif; 

} 

 

5. Перевірте чи шрифти мають однаковий вигляд при перегляді у графічному 

редакторі і при перегляді веб-сторінки lab9Lastname.html із веб-хостингу 

через браузер.   

6. Здайте роботу. 

https://youtu.be/GwA0BN5RgB0
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Контрольні питання 

1. Назвіть елементи фірмового стилю. 

2. Поясніть властивість логотипу "компактність". 

3. Поясніть властивість логотипу "масштабованість". 

 

Список рекомендованої літератури 

 

1. Дутчак М.С. Лекційний матеріал з дисципліни Web-дизайн. URL: 

https://drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-

ybqrjm62jQezKFC?usp=sharing 

2. Вивчіть Photopea. URL: https://www-photopea-

com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nu

i,elem 

3. Основи CSS. URL: https://css.in.ua/ 

4. Деякі онлайн інструменти, які дозволяють правильно підібрати кольори для 

дизайну сайту:  

● Adobe Color 

● ColorCode 

● ColrD 

● Cohensive Colors 

● ColorHunter 

● Tilda color 

 

 

  

Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
https://css.in.ua/
https://css.in.ua/
https://color.adobe.com/ru/create/color-wheel
http://www.colourco.de/
http://colrd.com/
http://javier.xyz/cohesive-colors/
http://www.colorhunter.com/
https://tilda.cc/colors/
https://tilda.cc/colors/
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Лабораторна робота 10. Структура та прототип  сайту 

Увага!  

 

Не забувайте, що всі завдання, які потрібно виконувати з допомогою web-

сервісів photopea.com, figma.com та Google документів, повинні виконуватися 

безпосередньо в них онлайн, а не шляхом завантаження файлів з локального 

ПК. ЗАВАНТАЖЕНІ ФАЙЛИ З ПК ПЕРЕВІРЯТИСЯ НЕ БУДУТЬ!!!  

 

 

Завдання: 

1. Розробити структуру веб-сайту у вигляді дерева або ментальної карти 

згідно розробленого бріфу. Вимоги до веб-сайту задані у лабораторній 

роботі 8.  

 

2. З допомогою photopea.com (або figma.com) розробіть прототипи головної 

та другорядних сторінок для пристроїв виводу, заданих у бріфі 

(обов’язково розробіть для екранної і мобільної версії сайту, для 

планшетної за бажанням). 

 При створенні прототипів з допомогою figma.com прототипи різних 

сторінок розміщуйте на різних фреймах. 

 

3.  Сформуйте і розмістіть у відповідних папках вихідний контент (тексти, 

фото тощо).  

 

4. Здайте роботу. 

https://docs.google.com/document/d/1aCDs_mT8kHCLFoGud1A0Pa6rAb4X-BLY/edit?usp=share_link&ouid=109219261408206469601&rtpof=true&sd=true
https://docs.google.com/document/d/1aCDs_mT8kHCLFoGud1A0Pa6rAb4X-BLY/edit?usp=share_link&ouid=109219261408206469601&rtpof=true&sd=true
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Список рекомендованої літератури 

 

1. Дутчак М.С. Лекційний матеріал з дисципліни Web-дизайн. URL: 

https://drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-

ybqrjm62jQezKFC?usp=sharing 

2. Вивчіть Photopea. URL: https://www-photopea-

com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nu

i,elem 

 

  

Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
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Лабораторна робота 11. Розробка ескізів сторінок сайту 

Увага!  

 

Не забувайте, що всі завдання, які потрібно виконувати з допомогою web-

сервісів photopea.com та figma.com, повинні виконуватися безпосередньо в них 

онлайн, а не шляхом завантаження файлів з локального ПК. ЗАВАНТАЖЕНІ 

ФАЙЛИ З ПК ПЕРЕВІРЯТИСЯ НЕ БУДУТЬ!!!  

 

ЗАВДАННЯ 

1. Створіть ескізи сторінок сайту відповідно до розроблених раніше бріфом, 

фірмовим стилем і прототипом. 

При створенні ескізів з допомогою figma.com ескізи різних сторінок 

розміщуйте на різних фреймах. 

 

2. Здайте роботу. 
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Список рекомендованої літератури 

 

1. Дутчак М.С. Лекційний матеріал з дисципліни Web-дизайн. URL: 

https://drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-

ybqrjm62jQezKFC?usp=sharing 

2. Вивчіть Photopea. URL: https://www-photopea-

com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nu

i,elem 

  

Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
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Лабораторна робота 12. Розробка графічного шаблону сторінок сайту 

 

Увага!  

 

Не забувайте, що всі завдання, які потрібно виконувати з допомогою web-

сервісів photopea.com та figma.com, повинні виконуватися безпосередньо в них 

онлайн, а не шляхом завантаження файлів з локального ПК. ЗАВАНТАЖЕНІ 

ФАЙЛИ З ПК ПЕРЕВІРЯТИСЯ НЕ БУДУТЬ!!!  

 

ЗАВДАННЯ 

1. Створіть графічний шаблон (фінальний макет) сторінок сайту форматах psd 

(або fig) і pdf відповідно до розроблених раніше бріфу, фірмового стилю і 

ескізів. 

При створенні шаблону обов'язково мають бути використані:  

при роботі у photopea.com: маска відсікання (Clipping Mask, див. лаб. 2), 

Smart Object (див. лаб. 4) для відображення різного вигляду кнопок, 

посилань, зображень в залежності від дій користувача, обов'язково задати 

зміну кольору, розміру тощо при наведенні вказівника миші. 

при роботі у figma.com: зв'язки для переходу між сторінками при кліку на 

відповідні елементи сторінки, анімації для відображення різного вигляду 

кнопок, посилань, зображень в залежності від дій користувача, обов'язково 

задати зміну кольору, розміру тощо при наведенні вказівника миші. 

2. Створіть Google Документ, в якому зафіксуйте опис елементів, які можуть 

викликати сумніви у верстальника, наприклад, скріншоти станів 

інтерактивних елементів з описом анімації. 

 

3. Здайте роботу. 

 

https://docs.google.com/document/d/1cXGmusA9aCL3bDCOlVF5mKTCbAdwI8HF/edit?usp=sharing&ouid=109219261408206469601&rtpof=true&sd=true
https://docs.google.com/document/d/1PDDuD53RFw9T6b4TpiCIZA_NBn5ymC3G/edit?usp=sharing&ouid=109219261408206469601&rtpof=true&sd=true
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Список рекомендованої літератури 

 

1. Дутчак М.С. Лекційний матеріал з дисципліни Web-дизайн. URL: 

https://drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-

ybqrjm62jQezKFC?usp=sharing 

2. Вивчіть Photopea. URL: https://www-photopea-

com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nu

i,elem 

 

 

  

Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
Дутчак%20М.С.%20Лекційний%20матеріал%20з%20дисципліни%20Web-дизайн.%20URL:%20https:/drive.google.com/drive/folders/1enhUE3vOOLE-vW8u-ybqrjm62jQezKFC?usp=sharing
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
https://www-photopea-com.translate.goog/learn/?_x_tr_sl=en&_x_tr_tl=uk&_x_tr_hl=uk&_x_tr_pto=nui,elem
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Лабораторна робота 13. Розробка веб-ескізу сторінок сайту 

ЗАВДАННЯ 

1. Створіть і розмістіть на веб-хостингу адаптивний веб-макет сторінок з 

допомогою CSS Grid на  основі фінального графічного шаблону. Сторінки 

зв’яжіть між собою посиланнями, на сторінках відобразіть всі необхідні 

зображення, анімації, стилі, зміни вигляду кнопок та посилань в залежності 

від подій вказівника миші і т.д. 

2. На стартовій сторінці веб-хостингу із переліком Ваших робіт вкажіть 

посилання на дану роботу. 

3. Папку із html i css файлами розмістіть на Google Drive. 

4. Здайте роботу у Google Classroom, вказавши посилання на папку роботи із 

Google Drive, а також вкажіть посилання на стартову сторінку веб-хостингу 

із переліком Ваших робіт. 
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